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WARNINGS: Measure Stability and Battery Discharge 
 

Measure Stability 

 

The MPP-EM2S+ is an accurate geophysical instrument. To obtain the 
stability of the base values (which should be around 0) and in order to 
avoid a drift of the signal, it is highly recommended to leave the 
probe and the DELLTM «ON» during one hour before taking the 
first measures. After the one hour’s delay, re-initialize the probe: you 
are now ready to take measures.  To minimize the drift once you’ve 
started to take measurements, initialize the probe every 1-5-10 or 15 
minutes to raise the reliability, depending of the accuracy that is 
wished. By default, the 1 minute is activated. 

If you want to take measurements right away after turning on the 
probe, we suggest to initialize the probe every minute or, for best 
results, before each reading for the first 30 to 60 minutes. 

This preventive procedure decreases the risk to take erroneous values 
that would be caused by weather variations or by other external 
causes and lead to a drift of the instrument. It is therefore very 
important to often re-initialize in order to maintain the «0» base value 
used in the calculation of the displayed values. 

Please take note that values are more stable after 20 minutes and are 
completely stable after 50 to 60 minutes. 

 

 

Battery Discharge 

 

It is recommended to put the DELLTM Axim on charge when not 
in use to avoid discharge of the batteries and potential loss of 
the GDD software. For example, if the DELL has been turned off, it 
will take 1 to 2 weeks for the battery to discharge, depending if you 
use the small or the big battery. If the batteries become discharge and 
you loose the use of the MPP GDD software, check the instructions in 
section 10 of this manual: How to restore the GDD software. To 
replace the backup battery, please refer to the Dell instruction manual. 
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Introduction 
 
Thank you for choosing the MPP-EM2S+ Multi Parameter Probe 
developed by Instrumentation GDD inc. to help you to optimize your 
prospecting efforts. This probe will help you to better determine the 
nature, the exact position as well as the intensity of 
magnetic/conductive horizons along your cores and samples. The 
simplicity of the measurement process and the automatic recording will 
allow to easily obtain conductivity and magnetic susceptibility profiles 
corresponding to the core.  
 
Here are the key benefits of the new MPP-EM2S+ probe:  

• It provides you the ability to measure at all time the magnetic 
susceptibility with or without the presence of a conductor such as 
pyrrhotite. 

• It has improved software to measure in continuous mode using a 
time base with specific lengths of your choice. 

• It is equipped with new software to present quickly a profile from 
the measurements taken in continuous mode. 

 
Because the probe's response towards a conductor is similar to a 
conventional electromagnetic (EM) survey's response, it will provide 
you more significant information than an ohm meter or a visual 
interpretation would do. To give an example, if the conductive zones of 
your core are evaluated by an ohm meter, the occurrence of 
chalcopyrite will induce a reading corresponding to a conductive zone. 
In fact, chalcopyrite, even if it seems massive, often, will not produce 
an anomaly detectable by a EM survey. Along the core, the MPP-
EM2S+ probe will have a similar response as the EM response and will 
only indicates the conductors detectable by this type of survey. The 
use of the MPP-EM2S+ probe could, therefore, avoid you to begin an 
EM survey campaign for a type of ore that would not respond to this 
approach. 
In the previous example, the phenomena allowing to explain the 
absence of conductivity is probably related to the chalcopyrite ore 
distribution in the sample. If the chalcopyrite grains are not touching 
each other but are linked only by very thin filaments, the ohm meter 
will detect the conductor presence because of those tiny filaments 
connecting them. However the grains, being linked only by those 
filaments, will not form a sufficient surface to be detected by the 
probe. 

 

For an equivalent content of conductive material, the probe response 
will be higher in function of the conductor's surface. You could try the 
following experience. Take an aluminium paper foil (a few cm square), 
put the probe on the sheet and note the intensity of the anomaly. Roll 
the sheet in a small ball, put the probe on the ball and take the 
reading again. You will see that the intensity of the anomaly is higher 
for a larger contact surface even if the substance conductivity and 
quality are the same. 
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Mineral Conductivity - General Rules 
 

Pyrrhotite often occurs in thin but continuous veins. It causes 
multiple and very high EM anomalies. 

 

Chalcopyrite is hardly detectable for two reasons. 

1 it is 20 times less conductive than pyrrhotite. 

2 it occurs, the more often, in disseminated grains or clusters rather 
than in continuous beds, as the pyrrhotite or graphite for which we 
can see continuous horizons of hundreds of meters. 

 

Pyrite and galena are not conductive when it responds to a EM 
survey even within a single crystal. However, we have observed some 
very conductive samples of silver-bearing galena (Kamouraska) and of 
rich in gold pyrite. (Balmorals and Wrightbar mines). 

 

Sphalerite, arsenopyrite and stibnite are never conductive and are 
not detectable with EM and IP surveys. 

 

Rich graphite beds can be more conductive than pyrrhotite. 
Occasionally it is not conductive at all. Graphite can also show all 
intermediary conductivity values. 

 

It is important to note that, with or without the presence of a 
conductor such as pyrrhotite, the MPP-EM2S+ probe will 
measure the magnetic susceptibility value. 

 

At all times, the MPP-EM2S+ provides an estimated 
conductivity value.  
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Equipment List 

 
Optional: NULL-modem cable (used to connect the probe directly to a 

computer) 

 

Assembling Instructions 
 

Power ON / OFF 
Pen 

 
 

1. Remove the black cap under the gun-shaped probe and insert 3 AA 
batteries. Put the cap back in place. 

2. Plug one end of the DB9 cable in the gun-shaped probe. 

3. Plug the other end of the DB9 cable in the DELLTM Axim X5 pocket 
computer. 

4. Turn the DELLTM Axim X5 pocket computer ON by pressing the little 
round button in the upper part of the computer. It is possible to 
choose different options by touching the screen with the pen located 
in the upper right corner of the pocket computer. 

5. Turn the probe switch ON. 
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Recharging the AA Batteries 

 
Simply put the AA batteries in the charger and plug it in the wall using 
the 120 V plug located at the back of the charger or the 220 V adapter. 

    
 

 

Recharging the Li-on Batteries  
 

The Li-on battery can be recharged with the charger plugged directly in 
the pocket computer (picture 1). The picture 2 illustrates how to 
change the Li-on battery located at the back of the computer. Use the 
pen to drag the black button to the left and then remove the Li-on 
battery. 

 

Picture 1    

 

Picture 2  
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The cradle can also be used to recharge both Li-on batteries 
(3400 mAH and 1440 mAH) at the same time. Put the 3400 mAH 
battery into the back slide of the cradle and the 1440 mAH battery into 
the DELLTM computer. Put the DELLTM computer in the front slide of the 
cradle.  

 
 USB cable 

120 V 

220 V 

Charger 

Cradle 

3400 mAH 
battery 

Pocket 
PC 

 
 

As you will see, the charger can be plugged to a 120 V or a 220 V 
outlet thanks to the adapter. You can also use it to download data to 
your own personal computer. To do so, use the USB cable. 

 

 

New Assets: «STAMP» and «MEMORY» Buttons 
 

There are now two buttons on the handle of the MPP–EMS2+ probe. 
These buttons have the same utility as the «STAMP» and «MEMORY» 
keys in the DELLTM Pocket PC and were designed to facilitate handling. 
The buttons are especially useful when using the PC software linking 
the MPP-EMS2+ probe directly to a computer as the user cannot tap on 
the Pocket PC screen. 
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Quick User’s Guide 

 
1. Charge and install AA batteries in the probe and the DELLTM 

module (these batteries are rechargeable) 

2. Start both instruments 

3. Start the «MPP_en» program 

4. Initialize the probe 

5. Configure parameters, i.e. fine name, spacing, mode, etc. 

6. Take the measures by pressing «MEMORY» space and increment 
the position by pressing the «STAMP» key on the DELLTM module 
or on the probe. 

7. Create a file to save the readings 

8. Transfer the file to your computer using the cradle. As shown on 
the picture, put the DELLTM Axim X5 pocket computer into the 
cradle. Plug the USB cable of the cradle in a USB port of your own 
computer. 
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Detailed User’s Guide 

1. Starting Point  

 
1.1 Unscrew the cap of the batteries space 
and insert charged batteries into the 
probe. Use rechargeable batteries given 
with the probe or use standard AA alkaline 
batteries. Make sure that the module's 
rectangular battery is charged and in 
place. Check if the probe is well connected 
to the DELLTM module using the RS/232 
cable. 

 

1.2 Turn on the module. To start up the 
MPP program, find the «MPP_en» icon in 
the «Start» menu. Click on the icon with 
the grey pen incorporated into the DELLTM 
module or with your finger. 

 

1.3 Put the switch of the probe to «ON» 
position. Move away the probe from any 
conductive or magnetic material (point it in 
the air) and click on the «INIT» command 
or in the GDD logo space to initialize. 

 

1.4 The «INITIALIZATION» message will 
flash a few times and then, it will 
disappear.  It is recommended to wait until 
values become stable and to initialize 
again. It is important to obtain the stability 
of the base values - which should be 
around 0 - in order to avoid a drift of the 
signal. This could lead to take erroneous 
measures. The probe is ready to begin 
measurements. 

 

1.5 If the «INITIALIZATION» message 
doesn't show off, check the connection 
between the probe and the module and the 
probe’s supply. 

 

1.6 If the sequence is not well followed the 
message «CONNECT TO» could appear. 
Simply choose «CANCEL» option to 
remove it. 
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2. Display 
 

The main screen is composed with three 
sections: The menu bar (1), the displayed 
measurements (2) and the memory space 
(3). At any time, you can go back to the 
previous screen by clicking on the «OK» 
icon in the top section of the screen, in the 
right side. 

 

Several times per seconds, the probe 
measures and display three physical 
properties which are: 

 

 

«HF RESPONSE»: Conductor response measured in Hertz (Hz). It 
measures low frequencies variation. Its value increases with the 
quantity of conductive material in the sample. It decreases with the 
distance between the probe and the sample. 

 

«SCPT 0.001 SI»: Magnetic susceptibility measured in 10-3 SI. Its 
value increases with the quantity of magnetite in the sample and 
decreases with the distance between the probe and the sample. It is 
important to note that, with or without the presence of a conductor, 
the MPP-EM2S+ probe will measure the magnetic susceptibility value 
at all times. 

 

«COND MHOS/M»: Conductivity measured in MHOS/M. It is 
independent of the quantity of conductive material in the sample ( HF 
Response) and independent of the distance between the probe and the 
sample. 

 

 

Under the measures space you can find a space reserved to the sample 
or core identification. The memory space indicates how many readings 
have been taken and the depth value (position along the core) of the 
measure to come. 
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3. Configuration 
 

 

 

 

 

The «CFG» command on the main menu 
gives access to four configuration pages: 
READING, SOUND, REINIT and MEMORY. 
This menu gives you also access to the 
graph mode. 

 

 

 

3.1 Reading 

The «READING» page allows to identify 
the core or sample’s name. 

 

It is recommended to give different names 
for each set of measurements to facilitate 
data interpretation. To enter a name or 
numbers, click on the keyboard icon 
situated at the bottom in the right corner. 
A keyboard will show. Click again to 
remove it. 

 

You can determine the initial depth value at 
which you will begin to take 
measurements. You can also determine the 
spacing for which the depth (position along 
the core) is incremented every time you 
take a measurement. The user has the 
unity choice: «meters» or «feet». 

 

In the READING page, the two arrows will 
serve to increase or decrease the recording 
frequency for a continuous measurement 
process. You must keep it to «0 s» to 
record manually the data. For continuous 
measurements, you can choose the 
recording frequency from 0.1 to 60 
seconds. As soon as the frequency value 
will differ from 0, the probe will operate in 
automatic mode. Write «0» values in the 
spacing if you choose the automatic mode. 



 

 11

Manual Recording Mode  

 

Three spacing values can be chosen to give 
more flexibility to the measurement 
process. The position along the core will be 
incremented for every recorded 
measurement, according to the chosen 
core spacing. 

 

It is possible to switch from one spacing to 
the other by clicking on the spacing in the 
menu bar. See section 4.1 for the manual 
measurement process. 

 

Automatic Recording Mode (regular 
spacing) 

For an automatic measurement process, 
the chosen spacing should simply 
correspond to the distance that you want 
to cover by the continuous scanning along 
the core, before you interrupt the 
recording by pressing «MEMORY». In the 
continuous mode, even if the readings are 
recorded continuously, the position will not 
increment for every automatic reading. It 
will increment every time you will press the 
«STAMP» command appearing at the 
bottom of the screen. See section 4.2 for 
the continuous measurement process.  

At any time, one can go back to the 
previous screen to start the survey by 
clicking «OK» in the upper part of the 
screen.  

 

Automatic Recording Mode (irregular 
spacing) 

First, put «0» values in all 3 spacing fields. 
Go back to the main menu by clicking 
«OK». Click on the window under «SUSC. 
& COND. METER» to enter the distance at 
which you want to start your survey, using 
the keyboard. Then press «STAMP» at the 
bottom to confirm and close the keyboard. 
You are now ready to start the survey, as 
explained in section 4.2. 
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3.2 Sound 

The «SOUND» page allows the user to 
activate or deactivate the conductor 
detection sound signal. You can determine 
threshold detection value for the 
«HF RESPONSE». For values higher than 
threshold value, the instrument will 
advise of the presence of conductive 
material by a sound signal. 

 

 

 

 

 

If the sound signal is deactivated, a «#» 
character is added beside the 
«MEMORY» key. 

 

 

 

 

 

 

 

3.3 Re-Initialization 

The «ReInit» page allows to choose the 
lap time for which the user will be advised 
to re-initialize the probe. This preventive 
procedure decreases the risk to take 
erroneous values that would be caused by 
a signal drift. Weather variations or other 
external causes can lead to a drift of the 
instrument. It is therefore very important 
to often re-initialize in order to maintain 
the «0» base value used in the calculation 
of the displayed values. 

 

 

The user can choose a lap time of 1, 5, 10 or 15 minutes. By default, 
the 1 minute lap time will be activated. During measurements, the 
message «PLEASE INITIALIZE» will regularly appear on the screen 
(according to the chosen lap time) to advise the user. Simultaneously 
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a sound signal will be heard. A 30 seconds delay will be given to the 
user after which it will be no longer possible to take measurements 
without initializing. Once initialized, the probe can be used to pick up 
next measurement. 

 

3.4 Graph 

The «graph» option operates with a continuous sampling mode. Il will 
allow to visualize graphically, in real time, the continuous values 
measured by the probe. The HF values, Magnetic Susceptibility values 
and conductivity values will be visualized simultaneously. 

 

The Y axis is displayed in a logarithmic form (from 0 to 100 000). The 
Y axis unities are Hertz, 10 –3 SI or MHOS/M depending on the 
observed graph.  

The X axis corresponds to a time scale during the continuous 
measurement process. It could also be interpreted as a pseudo 
distance related to the probe displacement along the core or samples 
during the measurement process. 

 

 

The color legend used for the graphs is as 
follows : 

 

HF Response: Red (Hertz)   

Magnetic susceptibility : Green (10-3 SI)  

Conductivity : Blue (Mhos/m) 

 

When you choose the graphical 
visualization option, two parameters could 
be configured: the sampling frequency 
and the X axis scale. 

 

 

Sampling Frequency 

You can choose the sampling frequency for the values tracing the 
graph. The sampling rate could vary from 0.1 s and 5 seconds. For 
example, every 0.1 second the value measured by the probe will be 
written to trace the graph. 

 

X Scale 

You can choose 5 different values to configure the X axis scale of the 
graph, corresponding to time. With a larger value (5 for example) the 
distance between each value written on the graph will be larger. It will 
give the effect of a graph crossing faster the screen.  
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For a slower display speed of the graph, choose a smaller value. A 
larger density of written values will cover the same horizontal interval 
on the screen. It will give the effect of a graph crossing slowly the 
screen. Note that the X axis scale choice will not modify the graph. It is 
simply a visualization option. The default value is 3.  

 

3.5 Alarm 

A red message «LOW BAT» will appear in the top of the screen when 
it will be necessary to change or charge batteries. 

 

WARNING: When the batteries are low, the data recorded could 
be inaccurate. 
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4. Measurements 

 
4.1 Manual Mode 

To take measurements, put the probe at the initial position along the 
core (or sample) and press the «MEMORY» space (the «MEMORY» 
button on the probe can be used in the same way as the «MEMORY» 
space on the DELLTM pocket PC). The depth position always indicates 
the location where one should put the probe to take the next 
measurement. At any time one can switch the chosen spacing by 
clicking on the spacing menu, in the upper part of the screen. 

 

 

The user may erase a wrong reading 
stocked in the memory by pressing the 
«BACK» key. The program will ask the 
user to confirm the task. One may repeat 
this action as many times as necessary. 

 

When the sound signal indicates that you 
should initialize the probe, put the probe in 
the air and reinitialize (see section 3.3).   

 

 

 

Recommendations for the Manual Mode 

During the measurement process, the probe must be in contact with 
the core or samples to standardize the process.  

 

4.2 Continuous Mode (regular or irregular intervals) 

For a continuous measurement process you must choose the recording 
frequency (section 3.1). A red rectangle will appear at the bottom of 
the screen to indicate that the probe operates in automatic mode. The 
«STAMP» command will serve to put in memory some position 
references during the automatic measurement process (the «STAMP» 
button on the probe can be used in the same way as the «STAMP» 
command on the DELLTM pocket PC). The position («DEPTH») will be 
incremented according to the previously chosen interval. As for the 
manual mode, you can switch the chosen spacing by clicking on the 
spacing menu, in the upper part of the screen if you choose to work 
with specific intervals. You may also choose to work with irregular 
intervals. If so, enter «0» as the increment, then each time you start a 
new interval, enter the depth and press «STAMP» to confirm. In both 
cases you are now ready to pick up your readings. 

Put the probe at the initial position. Press the «MEMORY» space to 
begin the automatic recording while you begin to move the probe 
along the core. During recording, the «STAMP» rectangle will turn to 
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green to indicate the automatic recording process. When you have 
covered the chosen interval, press again the «MEMORY» space to stop 
the continuous recording. The «STAMP» rectangle will turn to red 
again. Press «STAMP» to increment the position value if you are using 
a regular interval or enter the beginning of your new interval (irregular 
interval). To carry on the automatic measurements put the probe at 
the beginning of the new interval to scan and repeat the process by 
pressing again in the «MEMORY» space.  

 

When the sound signal indicates that you should initialize the probe, 
put the probe in the air and reinitialize (see section 3.3). 

 

Recommendations for the Continuous Mode 

Try to keep a contact between the probe and the core. The tendency to 
slightly move the probe away from the core during the continuous 
process could induce slightly smaller values in the profiles. In addition, 
keep a constant displacement speed along the core. This will facilitate 
data interpretation. 

 

4.3 Graphic Automatic Mode 

For a graphic visualization, you can proceed the same way as for the 
continuous mode. However, no value can be recorded. A red rectangle 
will appear at the bottom of the screen. Press «START» to begin the 
graphic tracing. The rectangle will turn to green to indicate that the 
sampling has begun. The graphic lines will appear, in real time, at the 
right extremity of the screen. Simply press «STOP» to stop the tracing 
process. 

When the sound signal indicates that you should initialize the probe, 
put the probe in the air and press «INIT» within the rectangle, at the 
bottom of the screen. 

The «CONFIG» option will allow you to return anytime to the 
configuration page for the graph. 
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5. Memory and File Creation 

 
5.1 File Creation 

To be able to transfer the recorded data to a computer, one has to 
create a file previously. 

 

 

The «MEMORY» page allows the user to 
create files in which a set of readings will 
be recorded after the measurement 
process. By default, the program will 
record all the readings in the new file. 
However, one may choose to record only a 
measurement range. Note that the range 
values correspond to the reading numbers 
appearing beside the word «memory» on 
the main screen and not to the depth 
number. If one try to create a file with an 
inadequate range, an error message will 
appear.  

 

 

One can choose a name for the file otherwise, the file name is going to 
be the same as the last one written on the «READING» page. 

 

The «CREATION» operation will create the 
new file. If you try to write a file name 
already existing, a message will appear to 
ask if you want to replace the existing file. 
It is recommended to create a new file for 
each diamond drill hole on which 
measurements are taken. With the manual 
mode, the file will contain the names of the 
measurement sets, the numbers of the 
measurements, dates and hours as well as 
the physical properties values. Each name 
will be contained in an independent 
memory space. It explains why at the 
beginning of the measurement process - if 
you gave a name - the memory number 
appearing will be «1» whereas the position 

value will be «0» as default value. With the automatic mode, the file 
will contain the same information. However, in the «Position» column 
of the transferred file, the «auto» mention will appear for every 
automatic reading. When you will use the «STAMP» command, every 
position marked with the automatic mode will be contained in an 
individual memory space (see section 4.2 and the example of a 
transferred file in Annex 1 ). 
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5.2 Erase Memory 

The 32 MB memory allows to store a very 
large amount of readings. The 
«CLEAR MEMORY» key allows to erase 
all data stocked in the memory. A 
message will ask you to confirm your 
intention. The operation will erase all the 
readings but will not erase the files 
already created. It is therefore highly 
recommended to create files before 
cleaning the memory to avoid to redo the 
measurements. 
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6. File Transfer 

 
Before proceeding to the file transfer, 
make sure that the DELLTM's module 
drivers provided on the DELLTM CD are 
installed on your personal computer 
(see the DELLTM installation guide for 
details). To import a data file (in text 
format) put the DELLTM module in its 
charger and plug the charger's USB 
cable to the computer USB port. If the 
support is not included with the 
module, simply use the USB cable 

plugged to the module.  

 

Turn off the «MPP_en» program and access the files from your 
computer by going to: 

My Computer → Mobile Device → MPP  

 

Copy the files on your hard disk to be able to process your data. 
Afterward, one may import data within EXCEL to make graphs or to 
perform other processing operations. 

 

Within the transferred file, the signs associated to the values (see 
section 7) will be displayed in an individual column. The signs being 
separated from the values, it will be easier to process data in EXCEL. 
When a value is displayed with such a sign, it can not be recognized as 
a numerical value by EXCEL.  

An example of a transferred file is provided in the ANNEX 1.  

 

If you cannot access your created files when you try to localize them 
from your computer: 

1 Make sure that the «MPP_en» program is off. 

2 Find in the main menu of your DELLTM module: 
Start → ActiveSync → Tools → Options 

3 Select: «Enable Pc Sync using this connection» 

4 Make sure that the «USB» option is selected in the window.  
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7. Readings Interpretation 

 
7.1 HF/Cond Distinction 

In the case of conductive sulphides: The HF response provides an 
indication of sulphides quantity. The Conductivity (Mhos/m) provides 
an indication of sulphides quality. The conductivity of a small and a 
large aluminium foil will be similar but the HF response will increase 
with the size of the aluminium surface. 

 

7.2 Results Signification 

«HF RESPONSE»: The number in this window represents the value of 
the HF response. 

 

«SCPT 0.001 Magnetic Susceptibility»: The number in this window 
represents the value of the magnetic susceptibility As mentioned 
previously, it is important to note that, in the presence of a conductor, 
the MPP-EM2S+ probe will measure the magnetic susceptibility value. 
In the presence of pyrrhotite combined with a small amount of 
magnetite or no magnetite at all, the magnetic susceptibility will be 
measured. 

 

«COND MHOS/M Calculated Conductivity»: It is important to note 
that in the presence of some magnetite in the sample, the MPP-EM2S+ 
probe will overestimate the conductivity value.  

The « > » sign appearing before conductivity value indicates that real 
conductivity is higher than 999999.  

The « XXX XXX » sign indicates that the conductivity may be present 
or not. 

 

7.3 Sample Shape and Distance 

The measured values could depend on the shape of the sample. For an 
equivalent content of conductive/magnetic ore, the response will 
increase with an increasing surface of contact. 

 
In the same way, the response will decrease with an increasing 
distance between the probe and the sample.  
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8. Battery Supply  

 
It is strongly recommended to always keep a charged battery within 
the module. The backup battery, on the back of the module, should 
supply only during the short time needed to change the main battery. 
A part of the GDD program is dependent of the supply. If, by accident, 
the total supply is cut, you will loose not only the data stored in the 
memory but also some elements needed to operate the program. It is 
therefore suggested to put the DELLTM Axim on charge when 
not in use to avoid discharge of the lithium batteries and 
potential loss of data or software. When you acquire the module, 
an initial backup has already been done, allowing to retrieve the 
elements needed to the software operation with the «restore» process 
described in section 10. The initial backup file is named «GDD». 

 

 

 

 

To check the remaining battery supply, go 
to «Start → Settings», and tap on the 
System tab at the bottom of the screen. 
Then, tap on the «Power» icon to open the 
power settings. Please note that it may take 
a few seconds (sometimes up to one 
minute) to refresh the remaining battery 
supply. 

 

 

We recommend the following steps:  

• Check that the Backup battery is at 
100% capacity. Change it if it is not 
full.  

• Check that the main battery is also 
full. Recharge it if necessary. 
Please note that the small 
battery should not be used, 
unless the main battery is being 
replaced.  

• In the «ADVANCED» tab, uncheck 
the «Turn off device if not used 
for…» button.  

 

• Tap OK in the upper right corner once you have finished. You will 
be brought back to the System settings. 
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9. GDD MPP Software Backup 
 

However, when you install a software update (section 12), it is 
recommended to perform the backup process described below to keep 
in memory the new software version. To avoid overloading 
unnecessarily the memory, it is recommended to overwrite the ancient 
backup file by naming the new file «GDD». 

 

 

If your software version does not contain 
the initial GDD backup file (first MPP 
versions, delivered before February 2004), 
it is strongly recommended to do the 
backup process as described below.  

 

1. Find in the main menu of your DELLTM 
module: 

Start → Programs → DataBackup  

 

 

2. Choose a name for your Backup file (we 
suggest «GDD»)  

 

 

3. Make sure that «Back Up All Data» 
option is selected. 

 

4. Click on «Start» 
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10. How to Restore Data and the GDD MPP Software  
 

If, accidentally, all the batteries become discharged and you loose the 
use of the program (section 8), you could retrieve the elements 
needed for the program with the «RESTORE» command. 

 

Before beginning the restoration process, a few steps must be taken. 
When you first open the DELLTM Pocket PC after the loss of program, 
the pocket PC will take you through the set-up process: 

 

1. Align screen: You must accurately tap 
the targets that show up on the screen. 
There will be one target in the middle of 
the screen and then one in each corner. 
The targets will keep appearing until 
they tapped precisely in their centre. 

2. Stylus: tap the «NEXT» button at the 
bottom of the screen. 

3. Pop-up menus: follow the instructions. 

4. Location: Select the time zone in which 
you are. The time zone can also be 
changed later. 

 

The set-up is complete.  

 

The restoration process can now be performed as follows: 

1 Plug the DELLTM module on the electrical circuit (the restoration 
process requires a lot of energy). 

 

2 Find in the main menu of your DELLTM 
module: 
Start → Programs → DataBackup 

3 There are two tabs at the bottom of the 
screen (Backup or Restore). Select 
Restore. 

4 Select «Restore from latest backup». 
As mentioned previously, the initial GDD 
backup is named «GDD.dbk» 

5 Click the «START» command at the 
bottom of the screen. 
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6 Once the restoration is finished, the following message will pop up: 
«Restore is complete. Press [reset] to restart the system». The 
«RESET» button is located on the side of the DELLTM module. You 
must press in the hole with the grey pointer stick to restart the 
module’s system.  

 
 

If you have installed a software update without doing a backup, the 
restoration of «GDD» file will not give back the last software version. 
In this case, after the «restore» operation, you must reinstall the 
software update as described in section 12.  

 

If your software version (delivered before February 2004) does 
not contain the «GDD» backup file: If you omit to do the backup 
process and lose your module’s memory, it will be necessary to 
reinstall the software from the original CD. The re-installation process 
is essentially the same as the process described in section 12 
(Software Update Installation). 

 

After the reinstallation, you will see that «MPP_en» will not appear 
anymore in the «Start» menu. To make it appear again as an option, 
the process is as follows:  

Start → Settings→Menus 

The list of the available programs will appear. You must remove a tick 
in a square of your choice and mark a tick to «MPP_en» (We 
recommended to remove all ticks on the Menu settings except 
«ActivSync», «File Explorer» and «MPP_en»). The «MPP_en» 
software will be available again in the «Start» menu. 
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11. Probe-Computer Connection (optional) 

 
If you chose the probe-computer connection, you can control the probe 
directly from your computer. 

• First, the MPP program must be installed on the computer with 
the MPP-PC CD. 

• Then, connect the NULL end of the NULL-modem cable to the 
probe, and the other end to the serial port of the computer. 

• Run the software (MPP.exe). The software works the same way as 
the DELLTM Pocket computer program (see previous sections). 

• If nothing happens when you click on «INIT», check in  
Config → COMM ports 
that the good port is selected. If it still does not work, check the 
probe’s batteries. 

 

WARNING: When the batteries are low, the data recorded could 
be inaccurate. 



 

 26

12. Software Update Installation 
 

You can always check if the software installed in your module 
corresponds to the last update by clicking on «Version» in the «Help» 
menu of your module. The number of the actual version will appear.  

If you are advised that a new update is available on the Internet (at 
www.gddinstrumentation.com), the following process will allow to 
install it: 

 

1 Install the DELLTM module in its charger support (cradle). 

2 Plug the module to the PC with the cradle USB cable (if the cradle is 
not included with the module, simply use the USB cable and plug it 
to the module) 

3 The connection is automatic. If it does not connect, check in 
ActiveSync that the connection is set to right port: 

ActiveSync → File → Connection settings… 

 

4 ActiveSync should open, 
and a window will pop up, 
asking for which type of 
partnership you desire. 
Click on «Guest 
Partnership». 

 

5 On the desktop of your PC 
click on «My Computer» 
icon. 

 

 

 

6 Open «Mobile Device» 
corresponding to the 
hardware of the DELLTM 
module 

 

 

 

7 Copy the software update from the CD or file (file with the .cab 
extension) to «Mobile device» directory. The update will be 
transferred to your module. 

8 Open the «Start» menu of the module 

9 Chose «File Explorer» in the main menu or in the «Program» 
group. 
 



 

 27

 

 

 

 

10 Go to «My Documents» file and 
click on the update file (.cab file)  
 
 
 
 
 
 
 
 

 

 

 

11 To the question «Re-install the 
software?», answer «OK». The 
update software will be installed 
automatically. You can now use the 
MPP system and log your core. 

 

 

 

 

 

 

If, for any reason, it does not work, you may always go back and re-
install the software from the original GDD CD. 

 

When the update is installed, it is important to redo the backup 
process suggested in section 9 to protect the new software version in 
the event that the batteries go down. 
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13. Importing a File in Microsoft Excel 

 
1 Open the Microsoft Excel software. 

2 In the tool bar, select File → Open 

3 At Files of type, select All Files (*.*). At Look in, you have to 
localize your file. This is very important in order to find the file 
you need. The file extension is .txt. Then select the file you want 
to open → Open 

 
 

4 You now have Text Import 
Wizard - Step 1 of 3. 
Select Fixed width. 
Select Next 

 
 
 
 

5 You now have Text Import 
Wizard - Step 2 of 3.  

Make sure that break lines separate 
the following titles: «U» (position 
35-37), «SYM» (position 37-41) 
and «SYM» (position 71-75).  
Select Next. 
 
 
 
 
 

6 You now have Text Import 
Wizard - Step 3 of 3. 
Select Finish. 

 

 

7 It is very important that you 
save your file now. To do so, go 
to the tool bar and select:  
File → Save as: 
Save in: choose the folder in 
which you want to save it 
Save as type: Microsoft Excel 
Workbook (*.xls) 
File name: choose the name 
you want to save and put the 
extension .xls at the end of the 
name. Select Save 
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14. Creating Profiles with the MPP-EM2S+ Data 
Processing Software 

 
It is possible to create a chart with the values obtained with the 
continuous reading mode. Once the values are saved in a text file and 
transferred to your own personal computer, do the following: 

 

1 Put the GDD Installation CD in 
your personal computer and 
open the directory called 
«4TMVR31». 
Double-click on the «Graph 
MPP» Excel icon to launch the 
application; 
 
 

2 A window asking if you want to 
enable the macros will appear. 
You must select «Enable 
Macros»; 
 
 
 

3 Click on the «START» window. 
Open your text document 
containing the MPP-EM2S+ 
values to be used in the chart; 
 
 
 

4 The charts are automatically 
created. Adjust the scales as 
needed and add titles or 
subtitles; 
 

 

5 The IP values are more accurate if the user reinitializes the MPP-
EMS2+ probe often (see the Warnings sections). 
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15. DELLTM Axim Module Characteristics 

 
If you have any question related to the DELLTM Axim module 
characteristics, you can refer to the DELLTM User’s Guide. For questions 
related to external properties of the module see DELLTM User’s Guide 
section 1.  

• Power button p. 12.  

• Light for screen display p. 12 

• Installing Main and Backup Batteries p. 16-17 

• Charging battery p. 19 

• Using the cradle p. 19 

It is recommended to consult the other sections of the DELLTM User’s 
Guide to learn about many other useful characteristics and facilities of 
the module.  

 

 

 

Here are a few suggested settings : 

Go to the menu «Start → Settings», and 
tap on the «System» tab at the bottom of 
the screen. Then, tap on the «Brightness» 
icon. 

 

 

 

 

Brightness:  

Put both battery power and external power 
to maximum brightness.  

In the «BATTERY POWER» tab, uncheck 
the «Dim if idle for more than …» button.  

In the «EXTERNAL POWER» tab, also 
uncheck the «Dim if idle for more than …» 
button. 

 

Clock: Set it to the right time. 

 

 

To select the items that will appear in the Start menu, go back to 
«Start → Settings» and click on the Menus icon. Many items will be 
checked, but only two are necessary. We suggest to remove all ticks 
on the Menus settings except «ActivSync» and «File Explorer». 
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16. Technical Support 

 
If you have questions or need technical support, do not hesitate to 
contact Instrumentation GDD Inc. 

 

Telephone:  (418) 877-4249 

Fax:   (418) 877-4054 

Toll free line in Canada and United States: 1 877 977-4249 

 

E-Mail:   gdd@gddinstrumentation.com 

 

 

Emergency out of business hours: 

 

Pierre Gaucher:  Res. tel.:  (418) 657-5870 
Cell phone:  (418) 261-5552 

Régis Desbiens: Res. tel.:  (418) 658-8539 
Cell phone:  (418) 570-3408 
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Annex 1: Example of a Dumped File 

 
Num      Date_&_Time    Position   SYM HF_Response SYM 
Scpt:0.001_SI SYM Cond:Mhos/m 
Échantillon 9045 

     2 04/02/2004 10:47:24    41.00 m >=            8 ?                  >=          0.1 
     3 04/02/2004 10:47:24    42.00 m >=            8 ?                  >=          0.1 
     4 04/02/2004 10:47:25    43.00 m >=            9 ?                  >=          0.1 
     5 04/02/2004 10:47:25    44.00 m >=            9 ?                  >=          0.1 
     6 04/02/2004 10:47:25    45.00 m >=            9 ?                  >=          0.1 
     7 04/02/2004 10:47:25    46.00 m >=            9 ?                  >=          0.1 
     8 04/02/2004 10:47:25    47.00 m >=            9 ?                  >=          0.1 
     9 04/02/2004 10:47:26    48.00 m >=           10 ?                 >=          0.1 
    10 04/02/2004 10:47:26    49.00 m >=          10 ?                 >=          0.2 
STAMP: 50.00 m 
    12 04/02/2004 10:47:35     AUTO   >=           12 ?                 >=          0.2 
    13 04/02/2004 10:47:35     AUTO   >=           13 ?                 >=          0.2 
    14 04/02/2004 10:47:35     AUTO   >=           13 ?                 >=          0.2 
    15 04/02/2004 10:47:36     AUTO   >=           13 ?                 >=          0.2 
    16 04/02/2004 10:47:36     AUTO   >=           13 ?                 >=          0.2 
    17 04/02/2004 10:47:36     AUTO   >=           13 ?                 >=          0.2 
    18 04/02/2004 10:47:36     AUTO   >=           13 ?                 >=          0.2 
    19 04/02/2004 10:47:36     AUTO                -3 IP?                 >=          0.2 
    20 04/02/2004 10:47:36     AUTO   >=           15 ?                 >=          0.2 
    21 04/02/2004 10:47:36     AUTO                -3 IP?                 >=          0.3 
    22 04/02/2004 10:47:36     AUTO   >=           15 ?                 >=          0.2 
    23 04/02/2004 10:47:36     AUTO                -2 IP?                 >=          0.3 
    24 04/02/2004 10:47:36     AUTO   >=           15 ?                 >=          0.2 
    25 04/02/2004 10:47:37     AUTO   >=           15 ?                 >=          0.2 
    26 04/02/2004 10:47:37     AUTO                -2 IP?                 >=          0.2 
    27 04/02/2004 10:47:37     AUTO   >=           15 ?                 >=          0.2 
    28 04/02/2004 10:47:37     AUTO   >=           15 ?                 >=          0.2 
    29 04/02/2004 10:47:37     AUTO                -3 IP?                 >=          0.3 
    30 04/02/2004 10:47:37     AUTO   >=           15 ?                 >=          0.2 
STAMP: 51.00 m 
    32 04/02/2004 10:47:40     AUTO                -3 IP?                 >=          0.2 
    33 04/02/2004 10:47:40     AUTO                -3 IP?                 >=          0.2 
    34 04/02/2004 10:47:40     AUTO                -3 IP?                 >=          0.2 
    35 04/02/2004 10:47:40     AUTO                -4 IP?                 >=          0.2 
    36 04/02/2004 10:47:40     AUTO                -2 IP?                 >=          0.2 
    37 04/02/2004 10:47:40     AUTO                -3 IP?                 >=          0.2 
    38 04/02/2004 10:47:40     AUTO                -2 IP?                 >=          0.2 
    39 04/02/2004 10:47:40     AUTO                -3 IP?                 >=          0.2 
    40 04/02/2004 10:47:40     AUTO                -3 IP?                 >=          0.2 
    41 04/02/2004 10:47:41     AUTO   >=         14 ?                   >=          0.2 
    42 04/02/2004 10:47:41     AUTO                -2 IP?                 >=          0.3 
    43 04/02/2004 10:47:41     AUTO   >=         30 ?                   >=          0.3 
    44 04/02/2004 10:47:41     AUTO   >=        150 ?                  >=          0.7 
    45 04/02/2004 10:47:41     AUTO   >=        600 ?                  >=          1.4 
    46 04/02/2004 10:47:41     AUTO   >=       2200 ?                 >=          2.7 
    47 04/02/2004 10:47:41     AUTO   >=       4400 ?                 >=          3.8 
    48 04/02/2004 10:47:41     AUTO   >=       6400 ?                 >=          797 
    49 04/02/2004 10:47:41     AUTO   >=       7900 ?                 >=          864 
    50 04/02/2004 10:47:42     AUTO   >=       9200 ?                 >=          904 
    51 04/02/2004 10:47:42     AUTO   >=      10500 ?                >=          968 
STAMP: 52.00 m 
    53 04/02/2004 10:47:42     AUTO   >=      11700 ?                >=         1021 
    54 04/02/2004 10:47:42     AUTO   >=      13000 ?                >=         1097 
    55 04/02/2004 10:47:42     AUTO   >=      13800 ?                >=         1170 
    56 04/02/2004 10:47:42     AUTO   >=      13800 ?                >=         1170 
    57 04/02/2004 10:47:42     AUTO   >=      14000 ?                >=         1223 
STAMP: 53.00 m 
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Annex 2 : Graphics from Manual and Automatic Modes 
 

 

 
 

 




